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1. Introduction
1.1. The purpose of this policy is to standardise practice across the University in terms
of the anticipation, identification and promotion of good practice in the preparation
and presentation of teaching and learning materials for the general benefit of all
students, but particularly for the support of disabled students, by mainstreaming a
small number of adjustments. In this context, ‘adjustments’ refers to types of
academic support that are typically and frequently recommended by the Disability
Support Office (DSO). An agreed minimum level of provision will reduce the
adjustments required for individual students, easing any additional work needed by
academic staff and others involved in organising support for disabled students.
1.2. The general principles of the policy are aimed at removing barriers for disabled
students to access teaching and learning materials and improving access for all.
These aspirations are in line with our duty to make reasonable adjustments under
the Equality Act 2010. This duty requires education providers to take positive steps
to ensure that disabled people can fully participate in their education and enjoy the
other benefits, facilities and services which education providers provide for their
students.
2. Competency standards and intended learning outcomes
2.1. Under the terms of the Equality Act, The University is not required to make
reasonable adjustments to intended learning outcomes or to professional
competency standards. It is therefore important that any intended learning
outcomes, including professional or other competency standards, are fully
understood and transparent. These intended learning outcomes and/or professional
standards themselves need to be justified under the provisions of the Equality Act,
and we may need to make adjustments to the ways in which these intended
learning outcomes or professional competency standards are met.
2.2. There are guidelines produced by professional bodies and organisations which
serve to protect the general public. Programme directors need to be guided by the
competencies required by particular professional groups (e.g., nurses, doctors,
teachers, psychologists etc.). An adjustment would not be made if it meant that the
student could not competently act within their field without the adjustment. However,
it should also be recognised that students may demonstrate that they meet any
required competency standards in different ways. The DSO can provide further
advice and guidance.
2.3. An intended learning outcome could be considered to be a competency standard
under the Equality Act. Again, the DSO can provide further advice and guidance.
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3. The Policy
3.1. All materials produced by The University of Manchester in support of its teaching
and learning activities should be accessible to as broad a range of students as
possible.
3.2. This policy applies to all students of the University and to all staff who teach and
support students.
3.3. Unless there is a justified pedagogic reason for not doing so, or the production of
such materials would appear to run contrary to competency standards (see Section
2.2), the policy applies to all programmes and units. Such justified pedagogic
reasons should be discussed with the DSO, and must be made clear to students in
advance in the programme handbook.
3.4. The guidance in Section 4 should be followed and applied.
4. Guidance for the production of inclusive teaching and learning materials
4.1. Printed documents
All documents should be produced, wherever possible, in keeping with the following
guidelines. This applies to documents that are intended for distribution in either
printed and/or electronic formats:
- All document structures should be kept simple.
Screen readers (used by blind or visually impaired people) work best
with well-structured documents. They read across a page from left to
right.
- Use a sans serif font such as, Arial, Verdana or Calibri etc.
- Use a minimum size 12 point font – the font should be large enough to be
read easily by most people.
- Write in plain English, avoiding jargon except for technical words.
- Staff should familiarise themselves with how to produce correctly
formatted documents. For example, see the TechDIS guide 1 for
producing accessible Microsoft Word documents.
As an example, this policy document has been produced using these
accessibility recommendations.
- Text should be left aligned. There should be enough white space to break
up the text. This can be done by adjusting line and paragraph spacing
settings.
- Use bullets and numbering.
- All pages should be numbered.
- Use the built-in header styles in Microsoft Word – this then enables users
to use the navigation pane to move around the document. Make use of
diagrams, flow charts, screen-shots, summary boxes and callouts to
1

http://www.jisctechdis.ac.uk/assets/Documents/resources/AccessibleDocsGuideWord10.pdf
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provide additional visual explanation. Consistently used pictograms can
draw attention to important procedures or hazards.
When using tables the header row should be specified and repeated
across different pages.
Add meaningful ‘alt-text’ 2 to tables and images
Images should be used in such a way as to not obscure text.
There should be sufficient contrast between the text and the background.
Where possible, use non-glossy paper, off-white is preferred for printed
documents.
Use hyperlinks so that readers can easily move to information in the same
document, a different document or a web page.

Further information:
Creating Accessible documents in Microsoft Word:
http://www.jisctechdis.ac.uk/techdis/multlinkres/detail/main_site/AccessibleDocsGu
ideWord10
Creating Accessible PDF Documents:
http://www.jisctechdis.ac.uk/techdis/resources/pdfs
4.2. Powerpoint-type presentations
- University templates3, or templates adhering to similar principles, should be used
in all cases.
- The layout should be simple and clear.
- The notes field should be used to expand on important points, or to describe
tables and diagrams. This will make the presentation more accessible for a
visually impaired person reviewing it later.
- If possible, the presentation should be checked and modified as necessary using
the accessibility checker. 4
- Alt-text and captions should always be used for any images.
- Images should not overlap or interfere with text.
- Any video materials should contain subtitles or alternatively a suitable transcript
of the content should be available for deaf or hard of hearing students.
- Any video materials should have descriptive voice-over options for blind or
visually impaired students.
- Be careful about the use of animations, and keep them simple.
Further information:
Delivering Accessible Digital Learning:
2

Alt-text (or alt tags) refers to text that is associated with an image that serves the same purpose and
conveys the same essential information as the image itself. Alt-textis used to help people using a screen
reader to understand the content of images and other non-text content in a document.
3
http://www.tlso.manchester.ac.uk/templates-teaching/. Versions of these templates are available in
Powerpoint (PC/Mac), Keynote (Mac) and Latex, both with and without the University logo.
4
Available in Microsoft Word 2010 onwards – with the mouse click on File tab, Info, Prepare for sharing.
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http://www.jisctechdis.ac.uk/techdis/resources/accessiblecontent
RNIB Guidance:
http://www.rnib.org.uk/professionals/accessibleinformation/text/Pages/clear_print.as
px
HEA Asperger Guidance:
http://www.heacademy.ac.uk/physsci/home/pedagogicthemes/accessibility/asperge
rssyndrome
4.3. Video-based materials
- Any newly produced video materials should contain subtitles or, alternatively, a
suitable transcript of the content should be available for deaf or hard of hearing
students.
- Any newly produced video materials should have descriptive voice-over options
for blind or visually impaired students
- File sizes should be made as small as possible.
4.4. Recording lectures
- Lecturers should facilitate the use of the lecture capture for all group-based
teaching and learning activities, where appropriate, and in line with the previous
agreed Policy on the Recording of Teaching and Learning activities 5.
- Video recording is not permitted without the explicit consent of the member of
staff involved, and upon recommendation as a reasonable adjustment from the
DSO.
- All teaching staff should ensure that microphones are turned on, worn and used
in all lectures when they are available, regardless of the perceived need to use
them.
4.5. Reading lists
Course unit reading lists should be supplied to the Library at least 8 weeks
before the unit is due to begin, along with an indication of the expected student
numbers for the unit. This will ensure the Library has sufficient time to identify,
purchase or make core materials available in the most appropriate format 6. All
reading lists should be sent to: uml.recommended-reading@manchester.ac.uk.
Unit Coordinators should provide students with reading lists, including book or
journal details, book chapters and relevant page numbers indicated. This will
normally be provided be provided at least 4 weeks before the start of the unit for
core material.
There will still be a need to provide some specific support tailored to individual
visually impaired students, identified by the DSO. In these cases, the School
5

Any lecture held in a room with lecture capture facilities can be recorded and made available to students for
their own use. The University Lecture Capture Policy applies to disabled students, and the right of a student
who is fully registered with the DSO (i.e., they have provided complete acceptable evidence of their disability)
overrides the staff opt-out option. Students are reminded that disciplinary action may be taken against them
for improper use of these recordings.
6
In order to support the principle of inclusive teaching and learning materials, and to maximise accessibility,
the Library will normally prioritise the purchase of electronic versions of reading list items.
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Disability Coordinator will work with relevant Unit Coordinators and the Library
Disability Support Team to identify and prioritise texts that require conversion to
an alternative format.
4.6. Marking the work of disabled students
Allowances should not be made for spelling and grammatical errors on
assessed work other than when a special sticker, provided to the student by
DSO, is affixed to it. For online exams, an electronic marker is provided, and
this identifies the need for the same marking considerations.
Any reasonable adjustments recommended by the DSO should also be applied
to in-class assessments. Staff will be notified separately of students with
support needs additional to those outlined in this standard practice.
5. Implementation of the policy
5.1 The Policy on Inclusive Teaching and Learning Materials will be supported by
advice from the DSO. The implementation of the policy is expected to take time.
It is not, for example, anticipated that adoption of the policy will mean that all
teaching and learning materials will adhere to all of the policy guidance by
September 2015. Rather, the adoption of the policy should signal that new
materials will be produced to adhere to the principles and guidelines outlined
here. Existing materials should be adapted in due course.
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6. Useful tools
Although the use of Microsoft products is far from ubiquitous, the following functions within
them may help staff to produce materials in keeping with the principles outlined within this
policy.
Outline view
This provides an outline of your document or presentation. It is available in the view tab in
Word and in Powerpoint.
Table of contents
If your document is correctly formatted, then a Table of Contents can be easily produced
from the References Tab in Word.
Navigation pane
The Navigation View (from the View Tab in Word) allows a reader to navigate quickly from
section to section in your document. This pre-supposes that the document has been
correctly formatted using the Styles available in Word.
Text-to-speech (TTS)
This is included with Word 2010 (PC). The simplest way to use this is to add the TTS icon
to the Quick Access Toolbar. To do this, go to the File Menu, and select OPTIONS. Click on
QUICK ACCESS TOOLBAR in the left hand pane. Change the drop down menu labelled
‘Choose Commands From’ to see the full range of options by selecting ‘Commands not in
the ribbon’. Then scroll down to select the ‘SPEAK’ command. Click the add button in the
middle to move it to the box on the right of the screen (this box lists the commands that are
currently available in the Quick Access Toolbar). This adds the SPEAK icon to the toolbar.
Selecting text, and then clicking the SPEAK icon will enable you to listen to the text being
read aloud.
On a Mac, the easiest way to use TTS is to use the built in OSX accessibility features in
system preferences and enable ‘Voiceover’. The toggle command to turn this on or off is
cmd ⌘-F5.
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